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Sobre el Plug-in SharePoint 
El plug-in SharePoint actúa como un puente entre Reform y SharePoint.  Permite 
archivar documentos procesados por Reform en bibliotecas de documentos de 
SharePoint donde puede compartir su colección de documentos 
 
Reform Enterprise/PDC maximiza la integración con Microsoft SharePoint para habilitar 
la entrega automática de información de documento desde cualquier sistema operativo, 
aplicación o dispositivo. Si se está imprimiendo un documento desde el host, analizado 
con un MFP o copiadora, o generado por un usuario de una aplicación, Reform 
capturará el proceso, extraerá el texto y lo archivara inteligentemente a SharePoint. Con 
opciones de entrada alternativas de Reform, se puede acceder a más de la información 
valiosa sin esfuerzo y compartirla fácilmente con empresas a través de SharePoint. 
Reform puede controlar ubicaciones de directorio, así como información de índice 
personalizada para simplificar la recuperación de documentos. Acceso rápido y fácil a 
información importante es un recurso vital, y capacidades de integración de Reform 
para SharePoint permiten obtener el almacenamiento de información más completo de 
documento para mejorar el flujo de trabajo de las operaciones del negocio. 
 

Requisitos del Sistema 

 Reform 12 Enterprise o Reform 12 PDC 

 Plugin Sharepoint  

 Para evaluación y demostración: Windows XP, Windows 2003 Server, Windows 
Vista, Windows 7 o Windows Server 2008 (se admiten los sistemas operativos de 64 
bits) 

 Para los sistemas de producción: Windows Server 2003 o Windows Server 2008 
(sistemas operativos de 64 bits son compatibles) 

 MS SQL 2000, 2005 cliente o servidor de MS SQL 2005 Express (la instalación de 
Sharepoint se descargará automáticamente e instalará SQL Express 2005) 

 Microsoft.NET Framework 2.0 (descargará e instalará automáticamente si no 
está ya presente en el sistema actual) 

 
Todas las descargas de software Reform necesario pueden encontrarse en 
www.fabsoft.com >> Sección de descargas. 

 

http://www.fabsoft.com/
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Requisitos del Hardware  
 Recomendación de Producción del Sistema (Estas sugerencias son sólo 

estimados. Entornos de alta carga pueden requerir varios servidores o 

hardware adicional.) 

1. Procesador Pentium 4 

2. 4 GB de RAM 

3. Espacio HDD de 100 GB (Redundancia Recomendada) 

4. Batería de Reserva (UPS) 

5. Servidor dedicado, no hay productos de software, excepto los 

programas de antivirus y de seguridad. 

 Requisitos mínimos del sistema para fines de demostración 

1. Procesador Pentium 4 

2. 2 GB de RAM 

3. Espacio HDD de 30 GB 

 
Especificaciones de hardware dependen enormemente de la carga de trabajo y el 
rendimiento que se requiere. Procesadores de gama superiores y una mayor cantidad 
de memoria aumentará la cantidad de información y datos que Reform puede procesar, 
mejorando el rendimiento general del sistema. Para equilibrio de carga y failover, 
también pueden utilizar varios servidores. (Nota: se requiere una licencia para Reform y 
cada Plug-in para cada Servidor que ejecuta el software.) Antes de obtener el servidor 
que desea utilizar para Reform, por favor revisar  los manuales de usuario de los plug-ins 
para requisitos del sistema, así como pueden requerir hardware adicional. Para sistemas 
de producción, se recomiendan también discos duros redundantes utilizando las 
características espejadas de RAID (matriz redundante de independiente discos) para 
minimizar la pérdida de datos y acelerar la recuperación del sistema en caso de una falla 
de hardware. También se sugieren respaldos de batería para mantener la disponibilidad 
del sistema y fiabilidad en caso de apagones 

 

Instalación  
Para instalar los componentes del Plug-in SharePoint Plug-in, debe descargar y ejecutar 
el ejecutable de instalación. 
 

 
Siga paso a paso a través de las instrucciones y aceptar el contrato de licencia de 
usuario. Comenzará la instalación.  Permitir que la instalación se complete y, a 
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continuación, ir a la siguiente sección para obtener información sobre cómo configurar 
la integración de SharePoint.  
 
El directorio de instalación predeterminado para Reform 12 y sus plug-ins es C:\Program 
Files\Reform. Si ha cambiado la ruta durante la rutina de instalación Reform, o si utiliza 
un sistema operativo de 64 bits, consulte la ruta adecuada en lugar de la 
predeterminada uno al que hace referencia a lo largo de esta documentación.  
 

Registro y Licencia del Plugin 
Al evaluar Reform 12, los plug-ins también estarán en un modo de evaluación para ese 
período de tiempo. Una vez que Reform ha sido comprado y con licencia, se debe poner 
licencia a los plug-ins usados para continuar funcionando correctamente.    
 
Consulte la sección "Reforma 12 licencias y registro" del Manual de Usuario Reform para 
más información acerca de cómo dar licencias a los Plug-ins de Reform 12.  Después de 
introducir la licencia, el Reform Spooler se tendrá que reiniciar para actualizar las 
licencias. Puede encontrar más información sobre el servicio Reform Spooler en el 
Manual de usuario de Reform 12. 
 

Mandando su Primer Documento a SharePoint 
Después de instalar el plug-in de SharePoint, es importante confirmar que se está 
ejecutando el servicio de SharePoint. Esto puede hacerse mediante el reinicio de la PC o 
iniciando manualmente el servicio. Para obtener más información sobre el inicio de 
forma manual, consulte la sección Iniciando el Servicio Sharepoint a partir del final de 
este manual.  
 

 

Muy Importante: 
Para obtener el nombre de usuario y la contraseña actual  para la demostración de 
Reform de cuenta de Sharepoint, ir a: http://most3.fabsoft.net/SharePoint/ (por favor, 
tome nota del nombre de usuario y contraseña que se utilizará durante la 
configuración.)  El nombre de usuario es: tutorial@fabsoft2.microsoftonline.com , ya 
que la contraseña se actualiza regularmente deberá ser obtenido de este sitio Web. 

 

http://most3.fabsoft.net/SharePoint/
mailto:tutorial@fabsoft2.microsoftonline.com
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En primer lugar, debe iniciarse el Reform Designer. Para abrirlo, ir a Start> Programs> 
Reform…> Designer. 
 

1. Por ejemplo, crearemos un nuevo formulario con una plantilla existente. Ir a File > 
New > New. Seleccionar SHAREPOINT.FTM y haga click en OK. 

 

 
 
2. Cuando le pregunte si desea abrir un archivo de texto para el diseño, seleccione No. 

 
3. Después, ir a File>Save para guardar su formulario. Llámelo SharePoint 

PackingSlip.FOM 
 
4. Ahora, usted puede cerrar el Reform Designer ya que tenemos nuestro formulario 

que va a utilizar junto con el Workflow Designer para distribuir el documento. 

 

* Ahora que tenemos nuestro formulario, podemos empezar a crear el flujo de trabajo 

de SharePoint deseado usando el Workflow Designer.  Primero, debemos iniciar el 

Workflow Designer.   

5. Para abrirlo, ir a Start>Programs>Reform…>Workflow Designer. 



Reform To SharePoint                                                                           7 

 

 

                                                                                                                                                                                                                                                                                                                              SharePoint 

6. Una vez abierto, ir a File > New… 

 

7. Seleccionar “Document Automation” y haga click en Ok. 

 
 

8. Ahora verá que sus entradas, procesos y salidas han sido pobladas por varios plug-

ins que han sido 0instalados (TagDoc siendo uno de los procesos) 
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9. Una vez abiertos, Podremos empezar a agregar los componentes necesarios para el 

flujo de trabajo. En primer lugar, arrastrar y soltar un objeto Form and File en el 

flujo de trabajo haciendo click y sosteniendo el mouse en Form and File, a 

continuación, mover el mouse sobre el flujo de trabajo y soltar el botón del mouse.  

 
 

** Aparecerá el siguiente cuadro de diálogo: 
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10. Escriba una descripción para el objeto que acaba de agregar. Para ello, escriba en el 

cuadro proporcionado. Escriba “Sharepoint Demo” y haga click en Finish. Esto le 

llevará de regreso a su flujo de trabajo. 

11. Ahora estamos listos para configurar el formulario de “Sharepoint Demo” y el 
archive de entrada.  Para ello, haga click derecho en el objeto recién agregado y 
seleccione  “Configuration…” o simplemente haga doble click en el. 

 
12. Ahora aparecerá la ventana Configuración de entrada.  En primer lugar, queremos 

que seleccione la secuencia de datos o archivo de texto que va a utilizar nuestro 
formulario.  Para ello, simplemente puede empezar a escribir en el cuadro o puede 
navegar hasta encontrarlo.  Queremos que seleccione el archivo 
SharePointPackingSlip.out.  Haga click en el icono de carpeta pequeña para abrir 
una ventana que nos permite escoger ese archivo.  Seleccione el archivo y haga 
click en Open   

 

 
 

13. Después de seleccionar el archivo de texto, volverá a la página de configuración de 
entrada para que ahora puede seleccionar un formulario.  Haga click en el icono de 
carpeta pequeña para abrir una ventana que nos permite escoger el archivo 
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deseado, el formulario SharePointPackingSlip.FOM.  Seleccione el archivo FOM y 
haga click en Open 

 
 

14. Ahora que tiene el archivo de texto de entrada y la reforma de formulario 
seleccionado, la instalación de “Form and File” está completa.  Puede rápidamente 
comprobar que los archivos correctos fueron seleccionados y, a continuación, haga 
click en Finish.  

 
 

15. También se pedirá que agregar un campo de salto de página a los formularios. En 
este punto, queremos seleccionar No. 

16. Para terminar el flujo de trabajo Sharepoint,  queremos agregar una salida 
Sharepoint.  Usamos el mismo proceso arrastrar y colocar como con el “Form and 
File” (ver paso 9).  Tomar el mouse y arrastre el "Sharepoint" bajo proceso de flujo 
de trabajo en algún lugar debajo de la entrada. Una vez que suelte el mouse, se le 
pedirá que describa “Sharepoint”.  Escriba “SharePoint Upload” en el cuadro y 
haga click en Finish. 
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17. Una vez que haga click en finalizar, volverá a su flujo de trabajo. Su SharePoint 
tendrá un título Rojo porque no se ha configurado aun. Para configurar SharePoint, 
primero debe conectar el objeto Form and File llamado “SharePoint Demo”.  Para 
ello, seleccione primero el botón “Add Connector” de la barra de menús.  N A 
continuación, arrastre el mouse de la pequeña “x” debajo de “SharePoint Demo” 
hacia la pequeña “x” encima de “SharePoint Upload” como muestra la imagen a 
continuación. Cuando se completa la conexión, el conector se volverá negro (si es 
roja, la conexión no se ha realizado correctamente, inténtelo de nuevo) y el título 
de “SharePoint Demo” cambiará a verde 

 
18. Deberá configurar SharePoint al finalizar la conexión.  Haga click en Yes.   I Si hace 

click en No, también puede hacer doble click en el objeto Sharepoint o click derecho 
y seleccionar “Configuration…”.  Esta configuración le guiará a través de todas las 
configuraciones necesarias para SharePoint para conectarse a un servidor de 
SharePoint y cargar archivos correctamente. La primera pieza de información es la 
posición del código de barras. Seleccione Lower Right y haga clic en Finish. (El 
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código de barras se puede mover en el diseñador después de ejecuta el flujo de 
trabajo). 
 

 
 
19. Para utilizar la demostración Reform cuenta de SharePoint, copiar y pegar o escriba lo siguiente 

para el ServerURL: 
https://fabsoft2microsoftonlinecom-4.SharePoint.microsoftonline.com/ 
 

 
 

20. Escriba el nombre de usuario. Haga click en Next.   
El nombre de usuario es: tutorial@fabsoft2.microsoftonline.com , puesto que la 
contraseña se actualiza regularmente deberá ser obtenido de nuestro sitio Web. 
(Consulte este sitio para obtener las credenciales actuales para reforma Tutorial: 

http://most3.fabsoft.net/SharePoint/) 
 

mailto:tutorial@fabsoft2.microsoftonline.com
http://most3.fabsoft.net/sharepoint/
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21. Escriba la contraseña y haga click en Next. 

(Consulte este sitio para obtener las credenciales actuales para reforma Tutorial 
http://most3.fabsoft.net/SharePoint/) 

 
 

22. Omita el campo dominio haciendo click en Skip. 
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23. Puede que deba esperar unos minutos mientras se está cargando las propiedades de 

SharePoint. Si ha introducido información incorrecta, cierre los cuadros de diálogo 
que pueden presentar y tratar de volver a la configuración. Cuando aparezca la 
ventana del asistente, escriba un Nombre de Archivo. Un nombre de archivo único 
ayudan a encontrar más fácil el archivo más tarde. Haga click en Next. 

 

 
 
24. Seleccione Tutorial para la Document Library donde desea cargar el documento. 

Haga click en Next. Nota: Si utiliza un servidor de SharePoint diferente que la que se 
describe en este tutorial, puede ver diferentes bibliotecas disponibles. 
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25. Seleccionar Tutorial para el directory y haga click en Next. 
 

 
 

26. La siguiente pantalla le pide el CUSTOMER NAME al cual el archive cargado será 
archivado.  Aquí nos gustaría utilizar datos disponibles en la secuencia de datos en 
lugar de un valor estático. Para ello, primero debemos pulsar el botón “Click here 
to select variable information”. Nota: Los atributos disponibles para la 
configuración se basan en el directorio seleccionado. Si selecciona una carpeta o 
biblioteca de documentos diferentes, puede ver atributos distintos de los 
enumerados en los próximos pasos de este manual. 

 



Reform To SharePoint                                                                           16 

 

 

                                                                                                                                                                                                                                                                                                                              SharePoint 

 
 

*Nota-Después de hacerlo, vemos que aparece una lista con los diferentes campos que 
puede elegir para los datos variables. Vamos a seleccionar de esta lista, pero si necesita 
escribir datos estáticos, puede hacerlo haciendo click en el botón correspondiente para 
obtener información estática y escribiendo en el. 
 
27. Ahora queremos utilizar ShipAddress como nuestro valor “CUSTOMER NAME”.  

Seleccionar ShipAddress  de la lista y haga click en Next 
 

 
 

28. Para “DATE”, nos gustaría volver a utilizar datos variables de la secuencia de 
impresión. Para ello, primero haga clic en el botón “Click here to select variable 
data”.  De la lista que aparece, seleccione ShipDate y haga click en Next. 
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29. Escriba 121280 para el Deal Number y haga click en Finish. 
 

 
 

30. Usted tiene que completar la configuración del flujo de trabajo sencillo de 
SharePoint. Los 2 objetos (“SharePoint Demo” y “SharePoint Upload”) deben ser 
verdes lo cual significa que se han configurado correctamente y está listo para 
crear el flujo de trabajo. 
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31. Para hacer todos los formularios y cambios adecuados, el flujo de trabajo se debe 

ejecutar.  Para ello, haga click en el botón “Execute”  en la barra de 
menús.   Después de la ejecución, se le notificará acerca de lo sucedido. Haga click 
en OK. 

 

 
32. Ahora puede cerrar el Workflow Designer. El formulario se ha guardado en el 

directorio de formularios predeterminado.  Un respaldo de su archive original 
SharePointPackingSlip.FOM se ha copiado a la carpeta “Workflow Designer 
Original Forms” en su directorio formularios.  Cualquier cambio de formulario 
permanente debe hacerse a su forma original ya que se utiliza en todo el proceso 
de configuración del formulario como plantilla. Si se realizan cambios en esta 
plantilla, tendrá que ejecutar el flujo de trabajo para ver los cambios en los 
formularios. 

 
33. Para probar la configuración y asegurarse de que se pueden cargar archivos, primero 

debemos abrir el formulario con el Reform Designer. Navegar hasta el directorio de 
formularios y haga doble click en SharePointPackingSlip.FOM.  Cuando se le 
pregunte abrir el archivo de texto asociado, haga click en Yes. Verificar que los 
campos especiales existen en la parte derecha del formulario.  

 
34. Ir a File>Print en el diseñador para mandar el documento a SharePoint. 
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Nota: Asegúrese de que se está ejecutando el servicio de SharePoint. Para obtener más 
información, consulte la sección Iniciando el Servicio SharePoint a partir del final de 
este documento para iniciarlo manualmente.  

 
Viendo el documento en el sitio de demostración de Sharepoint 
de Fabsoft 

1. Abra el explorador de internet y copie esta dirección http://most3.fabsoft. 
net/SharePoint/ 
 

 
 

1. Se le pedirá que introduzca el nombre de usuario y la contraseña en la siguiente 
pantalla, así que por favor, tome nota del nombre de usuario y contraseña. Haga 
click en Continue. 
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2. Escriba el nombre de usuario y la contraseña en la pantalla anterior. Haga click 
en Ok. 

 

 
 

3. En el lado izquierdo en Documentos, haga click en Tutorial para ver el documento cargado. 
 

 
 

4. Documentos cargados aparecen en la biblioteca del Tutorial. Puede abrir el 
documento y también ver los atributos asociados con el documento 
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Mantenimiento 
Hay ciertos directorios y tablas SQL que deben controlarse para crecimiento, junto con 
el plugin Sharepoint para Reform 12.  Cada vez que un sistema procesa más y más 
trabajos, el tamaño de estos directorios y tablas SQL puede crecer muy rápidamente. En 
general el rendimiento del sistema puede verse afectado por la gran cantidad de 
espacio que pueden ocupar los archivos.  Además, existe un límite de base de datos de 4 
GB si utiliza Microsoft SQL Server Express 2005 suministrado con la instalación. Entradas 
obsoletas archivos/base de datos se deben eliminar de acuerdo a sus necesidades y 
especificaciones de retención de archivos. Se recomienda monitorear el crecimiento de 
los siguientes directorios y tablas SQL: 
 
Directorios: 
C:\Program Files\Reform…\Backups 
C:\Program Files\Reform…\Spooler\ImageQueue 
C:\Program Files\Reform…\Plugins\SharePoint\Uploads 
 
Tablas SQL: 
SharePointTrans 
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Iniciando el Servicio SharePoint 
Ir a Start > Programs > Control Panel > Administrative Tools > Services 
Haga click derecho en RM_SharepointMonitor > Properties. Bajo Estado del Servicio 
haga click en Start. 
 

 
 

Este servicio actúa como un enlace entre Reform 12 y Microsoft SharePoint.  Permite a 
Reform cargar documentos y sus propiedades en el servidor de SharePoint.   

 

Solución de Problemas  
Q: No pasa nada después de que el formulario es procesado. Cómo puedo determinar la 
causa de un problema? 
A: Ver el Registro de Eventos para buscar errores relacionados con Reform o el servicio 
SharePoint.  Se puede accede al Registro de Eventos yendo a Control Panel > 
Administrative Tools > Event Log.   Esto generalmente le dará una buena idea acerca de 
por qué puede estar fallando el plugin de SharePoint. 
 

 
 
 

 
 

 
 
 
 
 

Otros nombres de empresas o productos mencionados en este documento pueden ser 
marcas comerciales o marcas registradas de sus respectivas empresas 


